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ThisUser's Manual isintended for SX-15, SX-12 and SX-8.

Thank you very much for purchasing the SX-15/12/8.

» To ensure correct and safe usage with a full understanding of this product's perfor-
mance, please be sure to read through this manual completely and storeit in a safe
location.

e Unauthorized copying or transferral, in whole or in part, of this manual is prohibited.

« The contents of this operation manual and the specifications of this product are
subject to change without notice.

e Theoperation manual and the product have been prepared and tested as much as
possible. If you find any misprint or error, please inform us.

¢ Roland DG Corp. assumes no responsibility for any direct or indirect loss or damage
which may occur through use of this product, regardiess of any failure to perform on
the part of this product.

¢ Roland DG Corp. assumes no responsibility for any direct or indirect loss or damage
which may occur with respect to any article made using this product.
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——  For the USA

FEDERAL COMMUNICATIONS COMMISSION
RADIO FREQUENCY INTERFERENCE
STATEMENT

This equipment has been tested and found to comply with the
limitsfor aClass A digital device, pursuant to Part 15 of the
FCC Rules.

These limits are designed to provide reasonable protection
against harmful interference when the equipment is operated
in acommercial environment.

This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance
with the instruction manual, may cause harmful interference
to radio communications.

Operation of this equipment in aresidential areaislikely to
cause harmful interference in which case the user will be
required to correct the interference at his own expense.

Unauthorized changes or modification to this system can void
the users authority to operate this equipment.

The /O cables between this equipment and the computing
device must be shielded.

—  For Canada

CLASSA NOTICE

This ClassA digital apparatus meets all requirements of the
Canadian I nterference-Causing Equipment Regulations.

CLASSE A AVIS

Cet appareil numérique de la classe A respecte toutes les
exigences du Reglement sur le matériel brouilleur du
Canada.
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1-6-4 Shinmiyakoda, Hamamatsu-shi, Shizuoka-ken, JAPAN 431-2103
MODEL NAME . Seethe MODEL given on therating plate.
RELEVANT DIRECTIVE : EC LOW VOLTAGE DIRECTIVE (73/23/EEC)
EC ELECTROMAGNETIC COMPATIBILITY DIRECTIVE (89/336/EEC)




How to Read This Document

This document is organized as follows.

Part1 Getting Started
This describes the preparations to make before you use the SX-15/12/8.
Read through this before you use the SX-15/12/8.

Part 2 Performing Cutting
This describes the basic steps for cutting.
Read through this when you're using the SX-15/12/8 for the first time.

Part 3 Mastering the SX
This describes features for further mastering use of the SX-15/12/8.

Part 4 User's Reference
This describes care, maintenance, and troubleshooting for the SX-15/12/8, and also contains the specifications of the SX-15/12/8.

The illustrations appearing in this manual depict the SX-15. The SX-12 and SX-8 may differ from the product shown.

For information about how to use theincluded Dr. STIKA PLUS program, see the PDF manual for Dr. STIKA PLUS on the Roland
Software Package CD-ROM, or refer to the program's help screens.

Windows® is aregistered trademark or trademark of Microsoft® Corporation in the United States and/or other countries.
TrueTypeis atrademark of Apple Computer, inc.

Other company and product names appearing herein are trademarks or registered trademarks of thier respective holders.

Copyright © 2001 Roland DG Corporation http://www.rolanddg.com/
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To Ensure Safe Use

About AWARNING and ACAUTION Notices

AWARNING

Used for instructions intended to alert the user to the risk of death or severe
injury should the unit be used improperly.

ACAUTION

pets.

Used for instructions intended to alert the user to the risk of injury or material
damage should the unit be used improperly.

* Material damage refers to damage or other adverse effects caused with
respect to the home and all its furnishings, as well to domestic animals or

About the Symbols

£\

"danger of electrocution."”

The A\ symbol alerts the user to important instructions or warnings. The specific meaning of
the symbol is determined by the design contained within the triangle. The symbol at left means

®

The ® symbol alerts the user to items that must never be carried out (are forbidden). The
specific thing that must not be done is indicated by the design contained within the circle. The
symbol at left means the unit must never be disassembled.

<

The . symbol alerts the user to things that must be carried out. The specific thing that must
be done is indicated by the design contained within the circle. The symbol at left means the
power-cord plug must be unplugged from the outlet.

AWARNING

®

Do not disassemble, repair, or
modify.

Doing so may lead to fire or abnormal
operation resulting in injury.

Ground the unit with the ground
wire.

Failure to do so may result in risk of
electrocution in the event of a mechanical
problem.

N

Do not use with any power supply
other than the dedicated AC adapter.
Use with any other power supply may lead
to fire or electrocution.

N

Do not use with any electrical power
supply that does not meet the
ratings displayed on the AC adapter.
Use with any other power supply may lead
to fire or electrocution.

O

Do not use while in an abnormal
state (i.e., emitting smoke, burning
odor, unusual noise, or the like).
Doing so may result in fire or electrocution.
Immediately unplug the power-cord plug
from the electrical outlet, and contact your
authorized Roland DG Corp. dealer or
service center.

Use only with the power cord
included with this product.

Use with other than the included power cord
may lead to fire or electrocution.



ACAUTION

O

Do not use with a damaged AC
adapter, power cord, or power-cord

plug, or with a loose electrical outlet.

Doing so may lead
to fire, electrical
shock, or
electrocution.

Do not damage or modify the
electrical power cord, subject it to
excessive bending, twisting, pulling,
binding, or pinching, or place any
object or weight on it.
Doing so may

damage the

electrical power

cord, leading to

fire, electrical

shock, or

electrocution.

N

When unplugging the electrical
power cord from the power outlet,
grasp the plug, not the cord.
Unplugging by
pulling the cord
may damage it,
leading to fire,
electrical shock,
or electrocution.

When not in use for several hours,
unplug the power-cord plug from the
electrical outlet.
Failure to do so may
result in danger of
electrical shock,
electrocution, or fire
due to deterioration of
electrical insulation.

Do not attempt to unplug the power-
cord plug with wet hands.

Doing so may
result in electrical
shock or
electrocution.

Do not allow liquids, metal objects
or flammables inside the machine.

Such materials %
2

can cause fire.

Install on a stable surface.

Failure to do so /

may result in the

unit tipping over,
leading to injury.

Do not touch the tip of the blade
with your fingers.
Doing so may result in injury.

)

O

Do not allow children to operate
without adult supervision or operate
within reach of young children.
Doing so may result in injury.

When using a commercially
available cutter knife for replacing
the blade protector, do not place the
hands anywhere along the path in
the direction of blade movement.
Doing so may result in injury.



About the Labels Affixed to the Unit

These labels are affixed to the body of this product.
The following figure describes the location and content of these messages.

Rating label
Use a rated power supply.

ACAUTION

DISCONNECT MAIN PLUG FROM

| SUPPLY SOCKET WHEN NOT IN USE _
MAIN LEADS COLOR CODE:

BROWN: LIVE, BLUE:NEUTRAL

A ATTENTION

Quand la machine n’est pas
utilisée déconnecter le
cable de la prise de courant

Code des couleurs
Marron:Phase, Bleu:Neutre

A ACHTUNG

Losen Sie den NetzanschluB,
wenn das Gerét nicht
verwendet wird.

Die Farbkodierung des
Netzkabels lautet folgendermaBen:
Braun:Spannung, Blau:Masse

AzE

ERRER LB,

/_-\FCg’577°5’&:I TV EDSIRNT
(A%

Model name

In additiontothe ANWARNING and AACAUTION symbols, the symbols shown below are also used.

NOTICE : Indicatesinformation to prevent machine breakdown or malfunction and ensure correct use.

N
|§ : Indicates a handy tip or advice regarding use.




Part 1 Introduction

Part 1 Introduction

1.1 Checking Accesories

Check the following to make sure that you received all the items that were shipped along with the unit.

Power cord : 1

i

Cableties: 2 Blade holder/Blade: 1
* For securing ferrite cores. *This blade holder and blade
areinstalled on the unit when
shipped from the factory.

Application tape for test cuts: 1

<~

SX-15/12/8 User's Manual : 1

Replacement blade protector : 1
*The configuration differs
according to the model.

Ferrite cores: 2

Material for test cuts: 1

Roland Software Package CD-ROM: 1

1-1



Part 1 Introduction

1.2 Part Names

Front View

Front cover

Blade Holder

Blade protector
STANDBY LED

Pinchrollers

Sheet adjustment levers

* The SX-15 has sheet adjustment levers on the left and right, and the SX-12 has a sheet adjustment lever only on theright.
The SX-8 has none.

Rear View
(@l
@ 6]
|
Parallel connector  AC adapter jack
Side View

& @\ STANDBY key

Sheset feed knob

1-2



Part 1 Introduction

1.3  Setting Up the SX
AWARNING

Ground the unit with the ground Do not use with any power supply
wire. other than the dedicated AC adapter.

Failure to do so may result in risk of Use with any other power supply may lead

electrocution in the event of a mechanical to fire or electrocution.

problem.

Do not use with any electrical power Use only with the power cord

supply that does not meet the included with this product.

ratings displayed on the AC adapter. Use with other than the included power cord

Use with any other power supply may lead may lead to fire or electrocution.
to fire or electrocution.

ACAUTION

Install on a stable surface.
0 Failure to do so

may result in the V

unit tipping over, [ S /7

leading to injury. e — }

-

NOTICE Neveringall thisunitinany of the following situations, asit could result in damage:
« Places where the installation surface is unstable or not level.
« Places with excessive electrical noise.
* Places with excessive humidity or dust.
« Places with poor ventilation, because the SX-15/12/8 generates considerable heat during operation.
« Places with excessive vibration.

Use within atemperature range of 5 to 40°C (41 to 104°F) and within a humidity range of 35 to 80%.

Make sure the power to the computer and the SX-15/12/8 is switched off before attempting to connect the
cables.

Securely connect the power cord, computer |/O cable and so on so that they will not be unplugged. Otherwise,
faulty operation or breakdown may result.

Installation Space

Do not place any object
within the area.

When cutting starts, the material moves forward and backward.
Do not place any objects within the areain which the material moves during cutting.

1-3



Part 1 Introduction

Connecting the Cables

Parallel connector Parallel connector
Use the screws on either side to Use the clips on either side to secure
s2cure the connector in place. the connector in place.

N
|\ —

Parallel Cable

The cable is available separately.
Be sure to use the correct cable for
the computer.

Attaching the ferrite cores

Attach the included ferrite core at the location on the connection cable shown in the figure.

20t0 30 mm | 20 to 30 mm (13/16 to 1-3/16 in.)
(13/16 to K from the connector on the SX-15/12/8
1-3/16in.)

N

*Secure in place with cable ties.

\ Cable tie ]

1-4



Part 1 Introduction

1.4 Installing and Setting Up the Included Software

System Requirements

- Microsoft® Windows® 95, Windows 98, Windows Me, Windows NT® 4.0, or Windows 2000 operating system
- The minimum required CPU for the operating system (Pentium® or higher recommended)

- The minimum amount of required RAM for the operating system (32 Mbytes or more recommended)

- 5 Mbytes or more of free hard disk space for installation

= . .

[=| | The Basics of Windows
Mouse operation

Pointing

When you move the mouse, the on-screen arrow (mouse pointer) aso moves. Moving the mouse pointer to line up the
tip of the pointer with an item on the screen is called "pointing."

Click < Click the right mouse )
Press and release the left mouse Press and release the right

button. é mouse button. E@
Drag i Double click 7
Move the mouse while holding ‘.3, Rapidly press and release

down the mouse button. @ L the left mouse button two é

times.

1-5



Part

1 Introduction

Installing and Setting Up Dr. STIKA PLUS and the Driver

The explanations in this manual assume that you are already familiar with the basic operation of Windows.

*

1-6

If you are installing under Windows NT 4.0/2000, you need full access permissions for the printer settings.
Log on to Windows as a member of the “ Administrators’ or “Power Users’ group.
For more information about groups, refer to the documentation for Windows.

Make sure the power to the SX-15/12/8 is turned off.

Switch on the computer and start Windows.

If you are installing under Windows NT 4.0/2000, log on
to Windows as a member of the “ Administrators’ or
“Power Users’ group.

Place the CD from the Roland Software Package in the
CD-ROM drive.
The Setup menu appears automatically.

When the screen at right appears, click the drop-down
arrow for [Click here] and choose the name of the model
you're using.

For the SX-15, choose [SX-15].

For the SX-12, choose [SX-12].

For the SX-8, choose [SX-§].

Before installing and setting up, click [Read me] for each
piece of software and read the information displayed.

= Aodaiw] Sidiess Packsge I CAEWE-T, ST =|

Roland
Software

= Faslarill Gepltwai o Promli aaps i ki1 GTECS x|

Dl Iulu._

Package

faar CARAM-T, ETINA

Irestall
U STmA PLUS Fead ma
Head Noor's / armal |
ireatall [ |
STIRA Dirkwar
Faad s |

'

G 1o Bpland DG Cang. Homep age |

— Roland

s LE] Lawyalegdaier

Continued on the next page



Part 1 Introduction

For [Dr. STIKA PLUS], click [Install]. =, Foflers] 5 oftmere Paokage or CAMM-1. GTRLA =
The Setup program starts.
Roland

Software
Package

Far CAMBM-T, STIER

@
D 5TIEA PLUS Read mo

Fmad lhife's W snusl
]

i \

Click [Next], then follow the messages to continue setting Wieltoms =
up the program. “wiakc s b i Do ST PLLES §aog progos
T his. el wall raminll O STICE PLUS o pesn
=rRE

T gl o rhat o sl ol "winedowd progoest
s rurerang thiss T plgRMr.

Dk, Losreosl o it S i haen o g o R
Fwvm wrveng Lok Ml i cordras sk ey [ 2

‘WAFRKRL Thz sogem i posced by copgghl e and
rhEr el e T

Uraativaeed regesdurries & dairke e, of th paegras o &g
ot ol B e ol i e ol wed coraral seralle .
vl ba preoseraied b e T

()] _co= |

When installation finishes, the screen shown at right ap-
pears.
Click [Finish], and finish installing the Dr.STIKA PLUS.

Srtup Commplein

ki Frwsh s ixalids Sabi

Viewing the PDF manual for Dr. STIKA PLUS.

The CD-ROM included with the SX-15/12/8 contains the
"Dr. STIKA PLUS User's Manual" as a PDF file. Roland
For [Dr. STIKA PLUS], click [Read the User's Manual]. Software
Acrobat Reader isrequired to view the PDFfile. If Acrobat

Reader isnot already installed and set up on your compulter, Fatkage
theinstallation program starts automatical ly. Follow the on- for CARIN-T, ETIKA
screen instructions.

= Hrdarad Sollmaie Paoksge lid CAHB-1. 5THCH

OrETIRAPLUE

* A printed version of the PDF manual for Dr. STIKA PLUS
is not included.
You can view it using Acrobat Reader, and use the
printing menu to output it to your printer as required.

1-7



Part 1 Introduction

Next, install the driver.

Thisisrequired when sending data from a Windows-based program to the SX-15/12/8. Be sure to install it.

1 O Make sure the model you're using is selected.
Before installing and setting up, click [Read me] for each
piece of software and read the information displayed.

11 For [STIKA Driver], click [Install].
Installation of the driver starts.

1 2 The driver settings appear.
Check the values, click [Close], and finish installing the
driver.

1 3 At the Setup screen, click 3| to close the window.
Remove the CD-ROM from the CD-ROM drive.

= Hodarwl Solieas Packsge i CAEHBE-T STIES =|

far CARM-T, STIKA

Irestall

T, S TR PLANS Read mo

Muad s Mamuad |

irenil [ |
STCE Difwar 3L
Baad rnh |
4
- ol 5 oftws Paoksge o CABM-1 STICA =
Roland
Software
Package
Far SAddN-T, STIKA
Treatall
T, STIEA PLUS Eeaid min

Muad Usis Wenuat |

i
e
Redomiz |
F )

STICA Dirfwar

Selbrngs 5 15]

Pt LFT1

Termout{secordst 100

Irgtallytgn compeled

[@

= | Faslrwl 5ot Pl aigs Pos CAME-1, FTIEA @

Software
Package

*|f the SX-15/12/8 does not operate when you send data from the program, take alook at "4.2 What to do if....".
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2.1

Place the material against the pinch rollers. Pinch rollers
L oad the material as shown in the figure, so that it does
not come loose during cutting.

Turn the sheet feed knob to align the forward edge of the \
material with the back of the blade protector.

Part 2 Performing Cutting

Part 2 Performing Cutting

Load the Material

Blade protector

Sheet feed knob

Do not use any of the following materials. The material may come loose during cutting or otherwise fail to be fed
properly.

Materials which has Material with a front Material with left and Material that is
curled upward edge that is not right edges that are longer than 1110 mm
straight not parallel (43-1/4in.)

) [ 4

2-1



Part 2 Performing Cutting

Using Roll Material

Material cannot be loaded on the SX-15/12/8 while still
attached to the roll.

?

Cut off from the roll alength of material equal to the Up to
require length for cutting plus amargin of 30 mm. 1100 mm
The SX-15/12/8 can be loaded with material up to 1100 (43-1/4 in.)

mm (43-1/4in.) in length. However, the cutting areais
only up to 1,000 mm (39-5/16 in.).

l

Q_
|§ - Cut off the material at aright angle.If the end of the roll material is not straight, then the next time cutting is per
formed material feed may not be performed correctly, and the material may move at an angle and come loose.

- Depending on the composition of the material, it may not be possible to cut some fluorescent or reflective material,
even if the material is of a cuttable thickness.

2-2



Part 2 Performing Cutting

2.2 Creating Cutting Data

This section explains the basic operation of Dr. STIKA PLUS while making the sticker shown below. For information on editing and
operation to match the task at hand, please refer to "3 Mastering the SX" or the help for Dr. STIKA PLUS and the driver.

>ALE

Starting the Software

1 Click [Start], and point to [Program].
Then point to [Roland Dr. STIKA PLUS] and click [Dr.

- z - =

STIKA PLUS]. I T = RolndCySTIRAFLLG & = DnSTIRAPLUS
ﬂ. S Lo iy * 8 Dn ETIEA FLLE Hew
2] Wirelom Exglon B i
A4, Erd . .
& o
11 am
.h_' Shu [ipeny
Sharl - oo Fasd

2 The opening screen appears and Dr. STIKA PLUS starts.

[T T p—
Fieinly [ S
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Part 2 Performing Cutting

2-4

Using Help

When creating data, if you're unsure about how to proceed, follow the steps below to view the help screens.
Also, when carrying out an operation for the first time, you can display help on your computer to guide you as you

proceed.

Displaying help screens

1 From the [Help] menu, click [Con-
tents].

2 Click the mouse on text (or figures) in
green to display an explanation or
related information.

Using the [?] button and [Help] button

If the window you'rein hasa[?] button in the
upper right-hand corner, you can use this
button to display context-sensitive help. Click
[?], then click the item you wish to know more
about.

If thereisa[Help] button in awindow, you
can use this button to display help about the
window.

= Urtitled - Dy STIEA PLUS
Ei= Ect ‘e [Obeect Hep

r_*|ﬁ|n|:.| Lo

Contents - Dr, STIKA PLUS Help

B Overview of Dr. STIKA PLUS

B Names and Functlons of Scraen Hems

L] DPI‘:HIHIH Procedures
Step 1 Iniroduchion

5%-15 on LPT1: Properties @ﬂ

I Optiohz I

3




If You're Using Windows 95/98/Me

From the [File] menu, click [Print Setup].
The [Print Setup] dialog box appears.

For the SX-15, select [Roland SX-15]. For the SX-12,
select [Roland SX-12]. For the SX-8, select [Roland SX-
8]. Then click [Properties].

The [Properties] dialog box appears.

* The screen at right is shown when [Roland SX-15] has
been selected.

Set the cutting range.
If you are using the included material, make sure the
cutting range is set to the following values.
SX-15: 340 mm (13.38 in.) (width)
270 mm (10.63in.) (length)
SX-12: 250 mm (9.84 in.)  (width)
390 mm (15.35in.) (length)
: 160 mm (6.29in.)  (width)
270 mm (10.63in.) (length)
* |f you're using SX-12/8, width is a fixed value.
@In [Cutting Area], for [Length], enter avalue larger
than the length of the data to cut.

SX-8

Setting the Cutting Range and Tool Conditions
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2-5



Part 2 Performing Cutting

A4

Click [OK].

If You're Using Windows NT 4.0

Comaent
Fiapss
-

*To change the settings for the various items, log on to Windows as "Administrator”" or as a member of the "Power Users' group.
For more information about groups, refer to the documentation for Windows.

1

2-6

From the [File] menu, click [Print Setup].
The [Print Setup] dialog box appears.

For the SX-15, select [Roland SX-15]. For the SX-12,
select [Roland SX-12]. For the SX-8, select [Roland SX-
8]. Then click [Properties].

The [Properties] dialog box appears.

Under [Document Options], choose [MediaSizeSettings].

Click the [MediaSizeSettings] button.
The [MediaSizeSettings] dialog box appears.
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Set the cutting range.
If you are using the included material, make sure the
cutting range is set to the following values.
SX-15: 340 mm (13.38in.) (width)
270 mm (10.63in.) (length)
SX-12: 250 mm (9.84 in.)  (width)
390 mm (15.35in.) (length)
SX-8 : 160 mm (6.29in.)  (width)
270 mm (10.63in.) (length)
* If you're using SX-12/8, width is a fixed value.
Click [OK].
The [Properties] dialog box appears.
@ |f you want to change the size, click [Add New Media
Size], and at [Media Size], enter the value for [Length].
@In [Cutting Ared], for [Length], enter avalue larger than
the length of the data to cut.

Click [OK].

If You're Using Windows 2000

Part 2 Performing Cutting

Med T Seling b A
Weda Gizes L Madk Sze Howe I:j
HN k=20 T
[ Mok il [ |
LUrsd

" pam T legh

M Size =
Aackd Pl Viashan S o ‘wich rT:l W
Dasmhsdasas | Lewm[TTT 2] [0

* Thisisthe screen that appears when you click [Add New
Media Size].

*To change the settings for the various items, log on to Windows as " Administrator”" or as a member of the "Power Users' group.
For more information about groups, refer to the documentation for Windows.

1

From the [File] menu, click [Print Setup].
The [Print Setup] dialog box appears.

For the SX-15, select [Roland SX-15]. For the SX-12,
select [Roland SX-12]. For the SX-8, select [Roland SX-
8]. Then click [Properties].

The [Properties] dialog box appears.

Click [Advanced)].
The [Advanced Options] dialog box appears.
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Continued on the next page



Part 2 Performing Cutting

A4

2-8

Choose [MediaSizeSettings], then click [Properties]. Rolared 53-15 Advanced Options i

The [MediaSizeSetting] dialog box appears.
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Set the cutting range. Merka Liee Sl g
If you are using the included material, make sure the biado Sicom Lt
cutting range is set to the following values. 'h-l'll'b\."‘."l'll'l
SX-15: 340 mm (13.38 in.) (width) HiwFcareld

270 mm (10.63in.) (length)
SX-12: 250 mm (9.84 in.)  (width)

390 mm (15.351in.) (length)
SX-8 : 160 mm (6.29in.) (width)

270 mm (10.63in.) (length) dikd Homw Buchn 5.=.|
* If you're using SX-12/8, width is a fixed value. T
Click [OK]. [

The [Advanced Options] dialog box appears.
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@ If you want to change the size, click [Add New Media
Size], and at [Media Size], enter the value for [Length].

@ In [Cutting Ared], for [Length], enter avalue larger
than the length of the data to cut.

@To select an added media size, then after you add the
size, again display [Print Setup], go to [Media Size
List], and select the saved size. Simply adding a media
size does not make the driver select it.

Click [OK].
The [Properties] dialog box appears.
Click [OK].

The [Print Setup] dialog box appears.
Click [OK].




Manipulating Text and Shapes

Entering and Saving Text

Part 2 Performing Cutting

The fonts that Dr. STIKA PLUS can use are limited to the TrueType fonts available for Windows. When selecting afont, non-TrueType
fonts are not displayed. Refer to the help screens for more information about using fonts.

1

The white area of the screen isthe cutting range. Any
portions that protrude beyond this area are not cut. Use
the zoom out function for Dr. STIKA PLUS to display the
entire cutting area on screen.

@ To zoom in or out, click Q , then click on the

desired area of the screen.

Left click:
Right click:

Zoom in
Zoom out

@ For more information about the cutting range, see "3.3
Cutting Range."

Click | A4 |

Click at the desired location, then enter "SALE" using the
keyboard.
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] L e S B Y o [ s ) e S | N

i i | DT PR Dl i (e L had
Rede =
= L] - [ 1SS FRATR = =1k

[ A e e pen
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Continued on the next page
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Part 2 Performing Cutting

= Uesalll - Bx AT PR =16
3 Click [[__]} Thisenclosesthe"SALE" text in arectangle Pl B8 Yem s Hib
O |= =S Ll L Trj&a e
so that only the area of the sheet around what is cut is J—'—I—l —IJ—l MM J_|E_H
peeled off.
G s | THLLIZE  Digonid ool
“
|§ -When you are cutting small text, you can make peeling easier by enclosing each single character in a square.

-All object overlapping is contextual, with the most recently created objects arranged on top. You can change the

context of objects by using the [,,E]l E]"Jl buttons. For detailed information, see the help screens or PDF manual
for Dr.STIKA PLUS.

4 Click | &

. = Ueillr] By NIWEA LR .ﬂlil
and save the data you've madeto afile. [ [ dee Qoet [t

2. Select where the
file is to be saved.

3. Type in the file name. Files
created with Dr.STIKAPLUS
have ".stx" as the extension.

Tpass [k o b I—L——I I
i o e LR I = Ca -_I =
ki [4. Click]™
|§ -The cutting range you set with Dr. STIKA PLUS is not saved. When you reimport saved data, check the cutting
range.

-To change the default font for Dr. STIKA PLUS, start Dr. STIKA PLUS, and before you type in text, go to the
[Object] menu and use [Font Select] to select the font you want to make the defaullt.

The changed font is applied only to text that you typein or select in Dr. STIKA PLUS.
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Part 2 Performing Cutting

Changing the Size

You can freely enlarge or reduce the
size by dragging up or down or to the
left or right.

Click | & |

Drag atext box with the mouse to change its size. Change the size
to fit inside the white portion of the display.

Cuespod | Wil EE Ol oess| M4 300 | Do 1L EE |wge| 0 Heml d
sy sl [ T T T

I
Thislets you confirm the
size of the text box.

Moving Text and Shapes

Click | & |then click the text.

Move the text by dragging it up, down, or to the | eft or right.

Cusspsd | THE O Dhsocess| Dand [eess @IAF sl B a
Fimsly om e e

E When the [View] menu command [Snap To Grid] is selected, text strings automatically snap to the grid. When you
want to move atext string to alocation off the grid, clear the selection for [Snap To Grid].
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Part 2 Performing Cutting

2.3  Starting Cutting

A\CAUTION

When not in use for several hours,

% unplug the power-cord plug from the
electrical outlet.
Failure to do so may
result in danger of
electrical shock,
electrocution, or fire
due to deterioration of
electrical insulation.

Before performing cutting, make sure the SX-15/12/8 has been prepared as described in the sections"2.1 Load the Materia" to "2.2
Creating Cutting Data"

1 Close the front cover and pressthe [STANDBY] key.

STANDBY Key

2 The [STANDBY] LED lights up and the carriage moves
as shown in the figure, then stops. -l STANDBY LED

3 Click|"=3'], then click [OK] in the dialog box that oluls

appears.
Datais sent to the SX-15/12/8 and cutting starts.

2-12



4 Rotate the material feed knob and remove the sheet.

5 Pressthe [STANDBY] key to switch off the power.
Make sure the [STANDBY] LED is not lit up.

Part 2 Performing Cutting

If You Want to Stop Cutting Before It's Finished...

1 Press the [STANDBY] key to switch off the power.

2 Click [Start]. Click [Settings], then click [Printers].

3 For the SX-15, double-click the [Roland SX-15] icon. For
the SX-12, double-click the [Roland SX-12] icon.For the
SX-8, double-click the [Roland SX-8] icon.

4 At the [Printers] menu, click [Purge Print Ducuments] or
[Cancel].
(If you're using Windows 2000, click [Cancel All
Documents].)
Make sure the displayed data for the file being printed
disappears.

_:l Py e "
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Part 2 Performing Cutting

2.4  Applying Cut Material

|§ When storing material that has been cut, be sure to cover it with application tape. This protects the material against
dust.
You can prevent the entry of dust inside the material by leaving an edge on the cut material at thistime.

1 Peel off excess portions of the sheet.
You can peel detailed areas easily using commercially
available pointed tweezers or the like.

2 Cover evenly with application tape so that no air bubbles
are trapped between the tape and the material, then
transfer the material to the tape.
You can transfer the material easily by using acommer-
cially available squeegee or the flat part of aruler or the
like to rub the cut material from above the application

tape.

3 Wipe away any dust or oil from the location where the
material isto be applied. <,

4 When transferring the material to the object, air may get

between the material and the transfer surface, forming air
bubbles. If this happens, use a needle to puncture the
bubbles, then press out the trapped air and affix the
material to the transfer surface.
Place the entire piece of application tape against the
object, then press down evenly on the tape, working from ///
top to bottom. While constantly making sure the material
has been transferred to the object, slowly peel away the
application tape.

2-14



Part 3 Mastering the SX

Part 3 Mastering the SX

3.1 Adjusting and Replacing the Blade
A\CAUTION

Do not touch the tip of the blade
with your fingers.

Doing so may result in injury.

)

NOTICE Whenmounting the blade holder, take care not to overtighten the blade retaining screw.
The cutter mounting screw may be broken.

Adjusting the Amount of Blade Extension

The optimal amount of blade extension is the same value as the thickness of the material (not including backing paper).
Material of the following composition and thickness can be cut.

- Composition Vinyl chloride sheets

- Thickness  Sheet portion :0.1 mm (0.00394 in.) or less, including base paper of 0.3 mm (0.0118 in.) or less

1 Switch off the power to the SX-15/12/8. Blade Hold
Loosen the screw and pull out the blade holder. ade Holder
—
T
‘ JQ
Screw

2 Rotate the tip of the blade holder in the direction shown
in the figure to extend the blade. Turning the tip by an T Y 0.1 mm
amount corresponding to one large scale gradation

(0.00394 in.)
extends the blade by 0.1 mm (0.0039%4 in.).

The amount of blade extension when shipped from the W . . .
factory is 0.1 mm (0.00394 in.). Only abarely visible portion of the blade tip

protrudes from the blade holder.

Insert the blade holder and tighten the screw.

Blade holder

—
%ﬁé‘iﬁg\

Screw

w



Part 3 Mastering the SX

Verifying the Amount of Blade Extension

NOTICE Be sure to load material before you carry out a cutting test. Failure to do so may damage the blade and blade

protector.

Do not move the carriage by hand. Doing so may result in breakdown.

Do not attempt to move the carriage by hand. Doing so may lead to faulty operation.

Perform a cutting test to check the results of adjusting the amount of blade extension.
With test cutting, the SX-15/12/8 actually cuts the material, allowing you to determine how well cutting is performed.

Test

1

cutting is performed when changing the type of material.

Load material.

Make sure the [STANDBY] LED islit and hold down the
[STANDBY?1 key for 2 seconds or longer. When the
carriage begins to move, release the key.

|§ The cutting test starts at the present location of the blade.
To perform continuous cutting tests, after the previous cutting finishes, again

hold down the [STANDBY?] key for 2 seconds or longer. This cutting test is

performed at alocation that does not overlap with the place cut previously.

Check the cut quality of the material.

The cutting quality is affected by the amount of blade
extension. Try peeling the cut sheet, and use the blade
holder to adjust the amount of blade extension accord-

ingly.
Tg _Theblade leavesfaint traceson  -The sticker cannot easily be ~The blade cuts into the backing
the backing paper when cutting peeled off of the backing paper. paper.
the cross. -Cut areas are not continuous. -The backing paper is cut through.

3-2

-Cutting results are misaligned.

Optimal amount of Amount of blade exten-
blade extension sion is too short

-The material peels during cutting.

t
gl

Amount of blade
extension is too long

Y




Part 3 Mastering the SX

Changing the Blade

If the material is still not cut attractively even after adjusting the blade extension and performing test cutting several times, the bladetip
may be broken. Replace it with anew blade.

1 Press the push-pin and remove the old blade. )
Push pin

L Blade holder

i
ll’
i
I

Blade

2 Insert the new blade firmly until it clicks into place.

S
-y
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Part

3 Mastering the SX

3.2 Setting the Tool Conditions

If You're Using Windows 95/98/Me

1

Start Dr. STIKA PLUS and display the [Properties] dialog
box.

For information on how to display the [Properties] dialog
box, refer to 2.2 Setting the Cutting Range.”

Click the [Tools] tab.

The [Tools] tab appears.

When using the included blade and material, thereis no
need to change the tool conditions. Make sure [Machine
Setting] is displayed and click [OK].

The [Print Setup] dialog box appears.

Click [OK].

Holand 5¥-15 on LPT1: Properties el |

Size Tools } O ptions ]

|::| Cancel | |

1T

If You're Using Windows NT 4.0

1

3-4

Start Dr. STIKA PLUS and display the [Properties] dialog
box.

For information on how to display the [Properties] dialog
box, refer to 2.2 Setting the Cutting Range.”

When using the included blade and material, thereisno
need to change the tool conditions. Click [Selected Tool],
and make sureit is set to [Machine Setting].

The [Print Setup] dialog box appears.

Click [OK].

| Feolard 53015 Document Piopeilbes il_l:l
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L
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Part 3 Mastering the SX

If You're Using Windows 2000

1 Start Dr. STIKA PLUS and display the [Properties] dialog
box.
For information on how to display the [Properties] dialog
box, refer to "2.2 Setting the Cutting Range."

2 When using the included blade and material, thereis no Ferdanil 515 Avarced Optaonms Rk
need to change the tool conditions. Click [Selected Tool],
and make sureit is set to [Machine Setting]. i Podand 52005 Advanced Dot Settings
Click [OK]. - :-:'; P il prd
The [Properties] dialog box appears. P ;g Hag 0
Click [OK]. fiy Cocumenst Cptions
The [Print Setup] dialog box appears. :;"r:_‘:"’l'_:""
Click [OK]. eectsd Took |[Fieis Seoe =]
£ Toold
5 Tod
- Toal &
- Tozd 4
High Amsolution; Off
:j Canzid |

Q‘_
|§ To Change the Tool Conditions
To change the tool conditions and use some- Roland S¥-15 gn LPT1: Proparies KR!
thing other than the included material, go to
[Settings] and change [Machine Settings] to e Took | apsons |
[1] or [2], [Tool 1], [Tool 2], and so on. Saifing ['1—;|
Enter the required values for [Speed], [Offset], :
Cutting Condilir:
and [Compensate].
For details about these items, refer to the help @ Curg (" Tesl
screens for the driver.
Swpind Offset
* The screen shown is for Windows 95/98/Me. - -
[ [or=n
The screens for Windows NT 4.0/2000 are 0 i P i
different. Conigarnzali
oo 3m Leina |
Commanis

3-5



Part 3 Mastering the SX

3.3 Cutting Range

Cutting range (width) Cutting range (length) Loadable material (width) | Loadable material (length)

SX-15 340 mm 1000 mm 360 to 381 mm 1100 mm
(13-3/8in.) (39-5/16in.) (14-1/8to 15in.) (43-Y4in.)

250 mm 1000 mm 280to 305 mm 1100 mm
(9-13/16in.) (39-5/161in.) (11to12in.) (43-Y4in.)

SX-12 250 mm 1000 mm 280to 305 mm 1100 mm
(9-13/16in.) (39-5/161in.) (11to12in.) (43-Y4in.)

SX-8 160 mm 1000 mm 200t0 215 mm 1100 mm
(6-1/4in.) (39-5/16in.) (7-13/16 t0 8-7/16in.) (43-1/4in.)

« The sheet behind the cutter holder cannot be cut.
« The front and the left and right side of the material are necessary margins to allow feed of the material by the pinch

rollers.

The cutting range is inside the dotted box.

If You're Using the SX-15

Pinch rollers

Blade holder

s
It

——Material

[ I’ ] o
—Blade protector —
Maximum
1000 mm
(39-5/16 in.)
\
Margines
30 mm 3 - .
(1-3/16 in.) Cutting range (width
250 mm (9-13/16 in.

‘Cutting range (width)

340 mm (13-3/8 in.)

Loadable material (width)
280 to 305 mm (11 to 12 in.)

3-6

Loadable material (width)
360 to 381 mm (14-1/8 to 15 in.)

If You're Using the SX-12/8

—— Pinch rollers

Blade holder

S

—

i
gl

Maximum
1000 mm
(39-5/16 in.)

|

—Blade protector

——Material

Margines

30 mm ry
(1-3/16 in.)

Cutting range (width)
SX-12: 250 mm (9-13/16 in.)
SX-8 :160 mm (6-1/4in.)

Loadable material (width)

SX-12: 280 to 305 mm (11 to 12 in.)
SX-8 :200 to 215 mm (7-13/16 to 8-7/16 in.)



Part 3 Mastering the SX

3.4 Changing the Loaded Material Width on the SX-15

The SX-15 can also use material of awidth for the SX-12 (280 to 305 mm (11 to 12 in.)) To change the loadable material width from 360

to 381 mm (14-1/8 to 15 n.) to 280 to 305 mm (11 to 12 in.), move the pinch-roller stoppers and change the driver setting for the cutting
range.

Change the Loadable Material Width to 280 to 305 mm (11
to 12in.)

1 Rai se the sheet adjustment lever on the right side.

Sheet adjustment lever
(right)

2 Detach the pinch-roller stopper from the machine.

Plnch roIIer stopper

3 Move the right pinch roller in the direction of the arrow. Pinch roller (right)

=
.

Move to here.

Continued on the next page
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4 Attach the pinch-roller stopper to the right of the pinch
roller.

S

6

Lower the right sheet adjustment lever.

Load material of awidth for the SX-12 (280 to 305 mm
(11to 12in.)).

Change the cutting-width setting for the SX-15 driver
from 340 mm to 250 (13.38 t0 9.84 in.) mm.

For information about how to change the cutting width,
see "2.2 Setting the Cutting Range and Tool Conditions."

Pinch-roller stopper

Pinch roller (right)

Sheet-adjustment lever
(right)

Roland 5X-15 on LPT1: Properties
Size l Toalz ] Dptiun&]

Cutting Area

Width : 2500 2 Click here and change

2]

the cutting width.
Length : E
Lrit -
&+ Millirneters
" lnches

* The screen shown is for Windows 95/98/Me.
The screens for Windows NT 4.0/2000 are different.



Part 3 Mastering the SX

Returning the Loadable Material Width to 360 to 381 mm
(14-1/8 to 15in.)

1

2
3

4

Rai se the sheet adjustment lever on the right side.

Detach the pinch-roller stopper from the machine.

Move the right pinch roller in the direction of the arrow.

Attach the pinch-roller stopper to the left of the pinch
roller.

Lower the right sheet adjustment lever.

Load material of awidth for the SX-15 (280 to 305 mm
(11to12in.)).

Change the cutting-width setting for the SX-15 driver
from 250 mm to 340 mm (9.84 to 13.38in.).
For information about how to change the cutting width,

see "2.2 Setting the Cutting Range and Tool Conditions.”

Pinch roller

(right)
I IW/
— 1:
—I\ Pinch roller
[s) (right)
—0 I— 11
Pinch-roller stopper
Roland 5X-15 on LPT1: Properties ed

Size lTDEﬂS ] Dptiuns]

Cutting &rea
Click here and change
Wwidth - #4004  thecutting width.
Length 270 4
Unit :
o Millimeters
" |nches

* The screen shown is for Windows 95/98/Me.
The screens for Windows NT 4.0/2000 are different.
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Part 3 Mastering the SX

3.5 Correcting the Slant of Loaded Material

If material is not loaded parallel with respect to the machine, the material may come loose during cutting.
If you're using the SX-15/12, you can use the sheet adjustment lever to correct the slant of material without removing the material from

the machine.
&
} ~——(—T T 1 @

Front of the machine

1 Rai se the sheet adjustment lever.

Sheet adjustment lever

2 Move the material to the front and back and position it so
that it is straight with respect to the machine.

3 Lower the sheet adjustment lever to secure the material in
place.

3-10



Part 3 Mastering the SX

3.6 Importing Windows Bitmap Format

You can import files and created data in Windows bitmap format (having the file extension *.bmp) into Dr. STIKA PLUS, perform
outlining for the data, and cut the data on the SX-15/12/8.

Depending on the image that isimported, some shapes that result may not be suitable for cutting. Keep the following conditions in mind
asyou create the data, then import it in Dr. STIKA PLUS. Refer to the documentation for the software you're using for information on
how to save filesin Windows Bitmap format (with the file extension *.bmp).

Conditions for Data That Yields Attractive Cutting Results

-Boundaries between two colors should be sharp and well defined, with no continuous gradations.
In general, photographs and scanning data contain continuous gradations and are not suitable for cutting.

-The resolution should be high.
Asagenerd guide, the original dimensions should be 200 dpi or higher.
It may take along time to import high-resolution datainto Dr. STIKA PLUS.

-The original image that you import should be the same size as or larger than the image to cut. .
When you import into Dr. STIKA PLUS an original image that is smaller than the size you want to cut, you cannot attractive
cutting results even by enlarging the image to the size you want. To obtain attractive cutting results, import an original image that
is larger than the cutting size, then reduce the image to the size you want.

For detailed information, see the PDF manual or help screens for Dr. STIKA PLUS.

Importing an Image

1 At the [File] menu, click [Import] to display the screen — 705
shown at right. : —
Click [File Type], then click [Windows Bitmap File Lock . | 3 Progeen =l & @ o) = m|
(*.bmp)]. Select the file to use, then click [Open]. ST et b
Fibs e |".1 i (i

Fibes of bopee |d\.'r\-1-1-\.l\.'.ﬁl'r\..q1Fl-Ihrr| ﬂ “| |

2 The image appears in the [Preview] dialog box. Click Frmaem |
[OK].

To extract attractive outlines, refer to the preceding

"Conditions for data that yields attractive cutting results’ .*.

and create the data. s I K A

Ligha et g Drdd - Drai
1 ()] oo |
Continued on the next page
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Part 3 Mastering the SX

3 The datain the selected file isimported. = i . L1604 1 ol
. . e P [ P Qe e
Adjust the size and positioning. nlwl@a| & w|e|[v Klaloioiol|o|a] et g

| o

]
Cammem A0 1D D 00T (00 B GO DB el & Bed B
Fau; [ [T

% The size of theimported original image and the size of the dataimported into Dr. STIKA PLUS are different.
Refer to "2.2 Creating Cutting Data" and return the size of the object to the size you want.

To Delete Unneeded Data

When an imported object includes unneeded data, you can del ete the unnecessary data using Dr. STIKA PLUS.

%ﬁ o] aje = §

1 Select the imported object.
At the [Object] menu, click [Break Apart].
The imported object is divided.

2 Click the unneeded data. — Usiilied - 0 STEA FLUS
[ Cd ‘P Dhist e

T e D S D el T N = R

Unneeded data
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3 From the [Edit] menu, click [Delete].
The unneeded data is deleted.

4 Restore the divided object to its origina state.
Use the mouse to drag and select all the objects you want

to combine.
At the [Object] menu, click [Combine Polygons].
To select all datain the Dr. STIKA PLUS window, go to
the [Edit] menu and click [Select All].
You can also select only the objects you want by holding
down the SHIFT key and selecting the objects.

Part 3 Mastering the SX
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Using a Scanner to Import an Object

You can import image data using a scanner.

An image acquired with a scanner can be imported into Dr. STIKA PLUS and outlined for cutting with the SX-15/12/8.

For detailed information, see the PDF manual or help screens for Dr. STIKA PLUS.

Dr. STIKA PLUS supports scanners that comply with TWAIN32. For information on connecting the scanner and installing the scanner

driver, please refer to the scanner's documentation.

Q—

depending on the original imported image.
Original image data

|E When you are scanning and cutting data such as bold logos, fill the original image before you scan it. Dr. STIKA
PLUS extracts the contours and performs outlining of objects. The portions that the SX-15/12/8 cuts may vary

\

A

\

Thisis cut asasingle object.

Two lines, one on the inner side
and the other on the outer side,
are cut.
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3.7 Applying Large Material

The larger the material is, the more difficult isit to apply while adjusting misalignment of the entire material, and the greater isthe
likelihood that air bubbles will get trapped between the material and the application surface.

Applying detergent-containing water to the application surface makes it difficult for air bubbles to form and lets you move the position of
the material asyou affix it.

1 Prepare the cut material.
Affix application tape to the top of the material.

2 Wipe away any dust or oil from the location where the
material isto be applied. /
: : ) /
Use acommercially available mister to spray a generous a4
amount of water containing two or three drops of neutral
detergent to the application surface.

3 Place the material on the application surface.
Adjust the positioning and angle of the material.

4 Use acommercialy available squeegee or aruler to
remove moisture.

5 After you have removed al moisture, slowly peel off the
application tape.
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Part 4 User's Reference

4.1 Care and Maintenance

ACAUTION

When using a commercially

® available cutter knife for replacing
the blade protector, do not place the
hands anywhere along the path in

the direction of blade movement.
Doing so may result in injury.

Cleaning the Blade Tip

Material scraps or adhesive adhering to the blade tip can adversely affect cutting.
Remove any buildup of material scraps or adhesive from the blade tip.

Cleaning the Blade Holder

Material scraps or grime that get inside the blade holder

can adversely affect cutting.

Take off the tip of the blade holder and remove any pieces

of material inside. < s
m Rotate the tip of the blade holder in the direction
4) shown in the figure to removeiit.

Cleaning the Machine

If the machine becomes soiled, wipe it clean with adry cloth.
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Replacing the Blade Protector

Slight scratching of the blade protector poses no problem for operation. However, the blade protector should be replaced if it becomes so
severely damaged that cutting is adversely affected.
Consult your vendor or your nearest Roland DG Corp. sales office for replacement of the blade protector. (Replacement of the blade
protector is acharged procedure.)

1
2

4-2

Switch off the power to the SX-15/12/8.

Peel off the blade protector from the machine.

Using acommercially available cutter knife or the like
may make peeling easier.

Remove the blade protector.

If you're using the SX-15, raise the |eft and right sheet
adjustment levers and remove the blade protector.

Use acloth or the like to wipe away any remaining
adhesive on the machine.

Place the replacement blade protector on the SX-15/12/8.

Use the reference line shown on the SX-15/12/8 as a
guide for alignment.

Peel off the double-sided tape and attach the included
replacement blade protector.

If you're using the SX-15, lower the left and right sheet
adjustment levers.

\ * Do not place the hands
~ anywhere along the

path in the direction of
blade movement.

N T

Reference line

1
0

Sheet adjustment levers
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4.2 What to do If...

The SX-15/12/8 doesn't operate.

Is the STANDBY key on (with the STANDBY LED lit up)?
The power is off. Press the STANDBY key.

Is the cable connected?
Switch off the power to the computer and the SX-15/12/8, and use a parallel cable (IEEE 1284-compliant) to connect the two
devices.
For information on how to make the connections, see "1.3 Connecting the Cables."

Is the correct type of cable used?
The type of parallel cable (IEEE 1284-compliant) may vary according to the computer model. Make the connection with the
correct type of cable for the computer.
Be sure the computer and the SX-15/12/8 are both switched off before attempting to attach or disconnect the printer cable
(IEEE 1284-compliant).

Is the STANDBY LED not flashing?
A communication error or command error has occurred.
Switch off the power and check the cable connections and port settings for the drivers.

Are the settings for the driver correct?
If the port setting is different from the port connected to the SX-15/12/8, make the setting for the connect port.

Is the printer port for Windows set to [ECP Printer Port]?
If the computer and the SX-15/12/8 are connected by a parallel cable and there is no operation, check the printer port for
Windows. If it is set to [ECP Printer Port], change it to [Printer Port]. For information on how to change the setting, contact the
manufacturer of your computer.

The SX-15/12/8 stops while cutting is in progress (and no error message appears on the computer screen).
Is the computer in energy-saving mode?
If the computer isin energy-saving mode, follow the steps below to turn off power management in Windows.
For information on how to change the setting, contact the manufacturer of your computer.

Pressing the STANDBY key does not switch off the power.
Unplug the AC adapter from the unit.

The Dr. STIKA PLUS doesn't function.

Does the computer you're using provide the correct operating environment for the included software?
Check "1.3 Operating Environment for Software" and make sure you're using a computer that meets the operating-environment
requirements.

Was the software installed using the setup program?
Be sure to use the setup program when installing the Dr. STIKA PLUS.
The setup program puts the files for each software package in the necessary locations to enable the software to be used under
Windows.

The system hangs (when you're using Windows NT 4.0 with Service Pack 3).
The system may hang when you type in text. This symptom is corrected by Windows NT 4.0 Service Pack 4 and | ater.
For more information, contact Microsoft.
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No squares or triangles (Il and A ) are displayed around objects.

Depending on the model of computer, squares and triangles (Il and A ) for mani pulating objects may not be displayed. The
following two workarounds are available. They affect the entire operating environment of the computer. For information on how to
change the settings, also see the help screens for Windows. You can view help for Windows by right-clicking with the mouse in the
corresponding dialog box.

1. In Windows, open [Control Panels].
Double-click [Display] to display [Settings].
Set [Color] to [256] then click [OK].
2. In Windows, open [Control Panels].
Double-click [System] to display [Performance].
Click the [Graphics] button.
Move the [Hardware acceleration] bar to the left until the square and triangle symbols (Jll and A ) around the objects appear.

Material cannot be cut properly.

Has the blade tip been adjusted?
Check whether the amount of blade extension has been adjusted. For information on how to adjust the amount of blade extension,
see "3.1 Adjusting and Replacing the Blade."

If the amount of blade extension is too short for the material
Cut lines may be discontinuous or unattractive, or the cutting results may be misaligned.
Adjust the length of blade extension to be the same as the thickness of the material.

If the amount of blade extension istoo long for the material
The material may peel off during cutting.
Shorten the amount of blade extension and change the driver setting to make the cutting speed slower.

Is the blade holder secured in place?
If the blade holder is not secured in place, it may be impossible to cut material.
Install securely so that the screws do not loosen while cutting isin progress.

Is the blade broken?
Cut lines may be discontinuous or unattractive, or the cutting results may be misaligned.
Replace with a new blade.

Is the size of the loaded material set correctly?
Material smaller than the set cutting range has been loaded. L oad material that matches the cutting range.

Is the cutting speed correct?
The cutting speed is too fast. Change the driver setting to obtain a slower cutting speed. Please refer to the relevant help screens
for the driver to set the cutting speed.

Is the driver for the model you're using installed?
Make sure the driver for the model you're using isinstalled.
If adriver for anincorrect model isinstalled, install the correct driver for the model you're using.

When cutting material measuring 500 mm (19-5/8 in.) or more, the material becomes displaced.
When material measuring 500 mm (19-5/8 in.) or more is loaded, then depending on its type, it may become misaligned.
If this happens, then either replace the material with adifferent type, or reload the material.

Cut lines are partially dotted (discontinuous).

The cause may be any of the follow.

Is the tip of the blade broken?
Replace with a new fresh, then use.

Is there any buildup of dust or material adhesive on the tip of the blade?
If there is buildup of dust or material adhesive, remove the blade and clean the tip.

Are there material scraps inside the blade holder?
Detach the tip of the blade holder and clean out any material inside the blade holder. See "4.4 Cleaning the Blade Holder" for the
procedure.
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Is the blade protector damaged?
If material is cut correctly even though the blade and blade holder are installed correctly, it means that the blade protector is
damaged. Replace with a new blade protector. For information on how to replace it, see "4.1 Replacing the Blade Protector.”

Is the blade holder broken or worn?
Replace with a new blade holder.

A message appears on the computer screen.

Is the message "Write error," "Out of paper," or "Timeout error" displayed on the computer screen?
Communication between the SX-15/12/8 and the computer is not correct. Switch off the power to the SX-15/12/8 and the
computer, then make sure the cable connections are correct. |f you are using a cable switching device, remove the switching
device

Is the [Add Printer Wizard] window displayed?
Make sure the SX-15/12/8's driver isinstalled.
If you connect the SX-15/12/8 to the computer and switch on the power to the SX while the SX driver is not installed on the
compuiter, then when you start Windows, the message [Add Printer Wizard] appears.
Follow the steps below to install the driver.

1. Click [Cancel].
2. Install the driver for the model you're using from the Roland Software Package CD-ROM.
For information on how to install from the CD-ROM, see"1.4 Installing and Setting Up the Included Software."
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4.3 Specifications

Main unit Specification

SX-15 SX-12 SX-8

Max. cutting area

340 mm (X) x 2000 mm (Y)
(13-3/8in. (X) x 39-5/16/in. (Y) )

250 mm (X) x 2000 mm (Y)
(9-13/16 in. (X) x 39-5/161in. (Y))

160 mm (X) x 1000 mm (Y)
(6-V/4in. (X) x 39-5/16in. (Y))

Acceptable sheet size*

Width : 360 to 381 mm
(24-1Y8t015in.)
Width : 280 to 305 mm

Width : 280 to 305 mm
(11to 12in.)

Width : 200 to 215 mm
(7-13/16t0 8-7/16in.)

(11to12in.)
Length: 1100 mm (43-1/4in.) or less | Length : 1100 mm (43-1/4in.) or less | Length : 1100 mm (43-1/4in.) or less
Cutting speed 12 to 100 mmy/sec. 12 to 40 mm/sec. 12 to 40 mm/sec.

(7/16 to 3-7/8 in./sec) (7/16 to 1-9/16 in./sec) (7/16 to 1-9/16 in./sec)

Acceptable material

PV C sheet (0.1 mm (0.00394 in.) or less in thickness, 0.3 mm (0.0118 in.) or less in thickness including the backing
board).

Control keys STANDBY key
LED STANDBY LED
Interface Parallel (IEEE 1284 compliant: Nibble mode)

Power consumption

Exclusive AC adapter DC+19V 2.1A

External dimensions 510 mm (W) x 165 mm (D) x 430 mm (W) x 165 mm (D) x 330 mm (W) x 165 mm (D) x
105 mm (H) 105 mm (H) 105mm (H)
(20-1/8in. (W) x 6-1/2iin. (D) x (16-15/16 in. (W) x 6-1/2in. (D) x (13in. (W) x 6-1/2in. (D) x
4-3/16in. (H)) 4-3/16in. (H)) 4-3/16in. (H))
Weight (unit only) 3.1Kg(6.81b) 2.6Kg (5.7 1b) 2.1Kg(4.61b)

Acoustic noise level

60 dB (A) or less (According to 1SO 7779)

Operation temperature

51040 °C (41 to 104 °F)

Operation humidity

351080 % (no condensation)

Accessories

AC adapter : 1, Power cord : 1, Ferrite cores : 2, Cable ties (For securing ferrite cores) :2, Blade holder/Blade : 1,
Material for test cuts: 1, Application tape for test cuts : 1, Blade protect : 1, Roland Software Package CD-ROM: 1,
SX-15/12/8 User'sManual : 1

*When material having a length of 500 mm (19-5/8 in.) or more is used, then depending on the type of material, it may become misaligned.

Interface Specification

[ Parallel ]
Standard

Input signal
Output signal
I/O signal level

Transmission method

IEEE 1284 compliant: Nibble mode

STROBE (1BIT), DATA (8BIT), SLCT IN, AUTO FEED, INT
BUSY (1BIT), ACK (1BIT), FAULT, SLCT, PERROR

TTL level

Asynchronous




Please read this agreement carefully before opening the sealed
package or the sealed disk package

Opening the sealed package or sealed disk package impliesyour acceptance of the terms and conditions of this agreement.

Roland License Agreement

Roland DG Corporation ("Roland") grants you a non-assignable and non-exclusive right to use the COMPUTER
PROGRAMS in this package (" Software") under this agreement with the following terms and conditions.

1. Coming into Force Thisagreement comesinto force when you purchase and open the seal ed package
or sealed disk package.
The effective date of thisagreement isthe date when you open the seal ed package
or sealed disk package.

2. Property Copyright and property of this Software, logo, name, manual and al literature

for this Software belong to Roland and its licenser.

The followings are prohibited :

(1) Unauthorized copying the Software or any of its support file, program module
or literature.

(2) Reverse engineering, disassembling, decompiling or any other attempt to
discover the source code of the Software.

3. Bounds of License Roland does not grant you to sub-license, rent, assign or transfer theright granted
under this agreement nor the Software itself (including the accompanying items)
to any third party.

You may not provide use of the Software through time-sharing service and/or
network system to any third party who is not individually licensed to use this
Software.

You may use the Software by one person with using a single computer in which
the Software isinstalled.

4. Reproduction You may make one copy of the Software only for back-up purpose. The property
of the copied Software belongs to Roland.
You may install the Software into the hard disk of a single computer.

5. Cancellation Roland retains the right to terminate this agreement without notice immediately
when any of followings occurs :
(1) When you violate any article of this agreement.
(2) When you make any serious breach of faith regarding this agreement.

6. Limitations on Liability Roland may change the specifications of this Software or its material without
notice.

Roland shall not be liable for any damage that may caused by the use of the
Software or by exercise of the right licensed by this agreement.

7. Governing Law This agreement is governed by the laws of Japan, and the parties shall submit to
the exclusive jurisdiction of the Japanese Court.
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